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1.	 INTRODUCTION
Thank you for choosing our SC100/200 Series Multi-function PID Controllers.

Before use, please check contents of the package you received as outlined below.  If you have any problems or questions 
with the product, please contact our sales office or representatives. 

SOFTWARE VERSION

The Model SFEW3E is usable with the SC100/200 Series Control Board Version 1.2 or later versions.

USERS MANUAL

This manual describes software functions of Loop Configuration Builder Software, PC environment and operation methods.  
Please refer to the relevant hardware users manuals for the detailed information about the terms used in this manual.

The following document will also provide helpful information when using this product:

			   • SC100/200 Series Function Block List (EM-6460-B)
			   • SC100/200 Series Function Block Application Manual (EM-6460-C)

1.1	 GENERAL DESCRIPTIONS

The SFEW3E is a Windows compatible software program for use with the SC100/200 Series Multi-function PID Controllers.

Main features include:

Graphical coding

Function block modules can be freely placed and inter-connected by drawing wiring between their communication terminals 
on the drawing board in order to configure the software connection information.  Visually grasping it reduces connection er-
rors.

Ladder logic sequence

Sequential control function blocks can be programmed using ladder sequence diagrams so that the user can visually confirm 
their operations.

Online monitoring

Status/values at the function block terminals of the device connected to the SFEW3E can be monitored in the Analog Termi-
nal Connection and Ladder Setting views.

1.2	 POINTS OF CAUTION & TERMINOLOGY

POINTS OF CAUTION

The SFEW3E is a programming tool dedicated for the SC100/200 Series Multi-function PID Controllers and the SML I/O 
modules, but developed as a limited version of the SFEW3 Loop Configuration Builder for use with our MsysNet Integrated 
Instrumentation System which is available for Japanese domestic sales only.  Some of the components and selections avail-
able in the program are for MsysNet System and therefore not used when programming the SC100/200 or the SML.

TERMS PARTICULAR TO MsysNet

Card

Hardware device (SC100/200 Series or SML) located on NestBus (our proprietary bus for MsysNet, RS-485 based).

Station (NOT USED)

Gateway device connecting the NestBus and the host communication network (L-Bus, our proprietary bus for MsysNet, Eth-
ernet based).  For use with the SC100/200 and the SML which are connected only to the NestBus, Stations 01 through 3F 
on the L-Bus are irrelevant.  Always use Station 00 slot to assign and set up each card.
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1.3	 SYSTEM REQUIREMENTS

PC IBM PC/AT or compatible

OS
Windows 10
Windows 11
Note: no guarantee for all environments

CPU 1 GHz or higher
Memory 1 GB or greater
Hard disk Approx. 100 MB required for installation

1.4	 RELATED PRODUCTS

PC Configurator Cable
Model: COP-UM

Used to connect the SML I/O module to the PC via a USB port.

Infrared Communication Adaptor
Model: COP-IRDA

Used to connect the SC100/200 Series to the PC via infrared communication.

PC Configurator Cable
Model: COP-US

Used to connect the SC100/200 Series to the PC via USB port.
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2.	 INSTALLING/REMOVING THE SFEW3E

2.1	 ADOBE READER

Adobe Reader is required to view HELP files in PDF format.

2.2	 INSTALLING THE PROGRAM

Get ready with a compressed archive of the SFEW3E downloaded at  web site.

Log in to Windows as administrator.  Expand the archive and locate setup.exe file in it.

1)	 Double-click the setup.exe file.
2)	 If “User Account Control” dialog box appears, choose ‘Yes.’

3)	 Windows starts the installation program for SFEWin3E software.  Follow instructions on the screen.
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4)	 Restart Windows when the installation is complete.
	 Note: The following setting must be performed when using Windows 10.
	 Open Task Scheduler from the Control Panel. (Control Panel > Administrative Tools > Task Schedule)
	 Expand the tree as in the figure below and go to the DiskCleanup folder.
	 (Task Scheduler Library > Microsoft > Windows > DiskCleanup)
	 Disable the SilentCleanup. 

2.3	 REMOVING THE PROGRAM

Log in to Windows as administrator.

Terminate SFEW3E.

Go to Control Panel > Add/Remove Programs or Programs and Features, and specify the SFEWin3E program.

Caution
Certain files and folders may not be removed automatically after the above procedure.  Locate them under Program 
Files\m-system\SFEW3E folder to remove.
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3.	 OPERATING THE SFEW3E

3.1	 STARTING THE SFEW3E

Go to Start > All Programs > M-SYSTEM > SFEW3E > SFEWin3E to start up the SFEW3E program.  System Configuration 
view initially appears as shown below.

Alternatively, double-click a project file icon or drag and drop it onto the SFEWin3E shortcut icon on the desktop.
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3.2	 VIEW CONFIGURATIONS

3.2.1	 VIEW LIST

System Configuration
Setting hardware configuration.  SC100/200 Series controllers and I/O modules (device 
modules) are placed and assigned with a card number.

Communication Terminal Connection
Connecting communication terminals to the device modules assigned in System Con-
figuration view.

Function Block List Setting function blocks for the device module.
Analog Terminal Connection Connecting analog terminals to the device module.
Sequential Control Block Setting Enabling/disabling sequential control blocks assigned in Function Block List view.
Ladder Setting Programming the sequential control blocks using a ladder sequence diagram.
Registry Monitor Monitoring specific terminals or ITEMs on-line
PU-2 Simulation Simulating the PU-2A Programming Unit operation to program modules.

3.2.2	 TRANSITION DIAGRAM

System Con�guration
Communication Terminal

Connection

Sequential Control
Block Setting

Analog Terminal
Connection

Ladder Setting

Function Block List

Close
button

Communication Terminal Connection
button

Close
button

Close
button

Double-click Card button, 
or click Card and choose 
Menu > Function Block 
List view

Click Card and choose Menu 
> Sequential Control Block 
Setting view

Choose Menu > 
Sequential Control 
Block Setting view

Double-click the module 
icon, or click it and 
choose Menu 
> Ladder Setting view

Choose Menu > 
Analog Terminal 
Connection view

Click Card and choose 
Menu > Analog Terminal
Connection view

Close
button

Close
button

Close
button

Close
button
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3.3	 MENU / TOOL BARS

3.3.1	 MENU BAR

File

New Used to create a new project while another existing project is open.
Open Used to open an existing project file.
Save Used to overwrite and save a project.
Save As... Used to save modified settings of an existing project as a new file.
Print Used to print the current view on the screen to the set-as-default printer.
Bulk Print Used to print multiple views specified on the Bulk Print dialog.
Properties Used to modify a project name and its comment.

Exit
Used to close the program.  If the current project is not saved, the program prompts its 
saving.

Edit

Undone Used to cancel the last command.  The program stores up to four last operations.
Redo Used to execute the last command once cancelled.
Cut Used to cut a graphic symbol on the Setting Window to paste it at another location.
Copy Used to copy a graphic symbol on the Setting Window to paste it at another location.
Paste Used to paste a symbol previously cut or copied.
Delete Used to delete a selected symbol on the screen.
Select All Used to select all symbols on the screen.
Comment Used to draw a text box and enter a comment in it.

View

System Configuration Opens System Configuration view.
Communication Terminal Connection Opens Communication Terminal Connection view.
Function Block List Opens Function Block List view.
Analog Terminal Connection Opens Analog Terminal Connection view.
Sequential Control Block Setting Opens Sequential Control Block Setting view.
Ladder Setting Opens Ladder Setting view.
Registry Monitor Opens Registry Monitor view.

Operation

Online Monitor
Starts online monitoring.  The menu description is replaced with ‘Offline’ while monitoring 
is running.

PU-2 Simulation Opens PU-2 Simulation view.
Option Opens Option dialog box for initial settings for the SFEW3E.
Port Setting Delete Deletes port information stored in ‘Option Dialog’

Window

Align Vertical Windows are arranged vertically in line on the screen.
Align Horizontal Windows are arranged horizontally in line on the screen.
Cascade View Windows are stacked over each other on the screen.

Help

Function Block List
Opens a list of Function Blocks.  Click on the abbreviation code of a function block to 
show detailed information on it.

Version Information Indicates the software version information of the SFEW3E.
Ladder Setting Shortcut Keys Shows a list of shortcut keys available in Ladder Setting view.



14SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

3.3.2	 TOOL BAR

ICON MENU FUNCTION DESCRIPTION

New Used to create a new project while another existing project is open.

Open Used to open an existing project file.

Save
Used to overwrite and save a current project.  For a new, untitled project, 
it is used to name and save it.

Print Used to print the current view on the screen.

Print Preview
Used to show preview images of the view on the screen.  Number of 
pages is indicated before preview.

Cut
Used to cut a graphic symbol on the screen to paste it at another loca-
tion.

Copy
Used to copy a graphic symbol on the screen to paste it at another loca-
tion.

Paste Used to paste a symbol previously cut or copied.

Undo
Used to cancel the last command.  The program stores up to four last 
operations.

Redo Used to execute the last command once cancelled.

System Configuration Opens System Configuration view.

Communication Terminal Connection Opens Communication Terminal Connection view.

Function Block List Opens Function Block List view.

Analog Terminal Connection Opens Analog Terminal Connection view.

Ladder Setting Opens Ladder Setting view.

Online Monitor Starts Online Monitoring.

PU-2 Simulation Opens PU-2 Simulation view.

Registry Monitor Opens Registry Monitor view.

Align Left Used to align selected symbols on the left.

Align Center Used to align selected symbols at the center.

Align Right Used to align selected symbols on the right.

Option Opens Option dialog box for initial settings for the SFEW3E.

Comment Used to draw a text box and enter a comment in it.

Zoom
Used to zoom the display scale to 200%, 150%, 100%, 75%, 50% or 
25% of the standard size.

Help
Opens a list of Function Blocks.  Click on the abbreviation code of a 
function block to show detailed information on it.
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3.4	 INITIAL SETTING (OPTION)

3.4.1	 OPTION

When the SFEW3E program has been started, first open “Option” dialog box and set up COM ports.

Go to Operation > Option on the menu bar or click the Option icon on the tool bar to open the “Option” dialog box as shown 
below.

3.4.2	 COMPONENT IDENTIFICATION

Port
Choose a COM port to be connected.
Communication adaptor cable name and respective port number are displayed.
Once recognized ports, are all displayed on the drop-down list.

Connection Device
Specify a device connected to the selected COM port.
Device and respective communication adaptor cable name are displayed.

Online Monitor Operation
Choose a transmission cycle during online monitoring.  ‘High speed’ is selectable for the 
SC100/200 series only.

Online Destination
Choose how to connect to the device during online monitoring.  ‘PU’ (local parameter 
setting port) or ‘L-Bus’ (network) is selectable.  Choose ‘PU’ for the SC100/200 Series 
and the SML.

Background Color Choose a background color of the views.

Grid View
Specify either you want grids displayed in the Setting Window on Communication Termi-
nal Connection and Analog Terminal Connection views.

Communication Specify the timeout value when the communication with the device is failed.

Note. The timeout value may be longer than the specified time.

3.4.3	 PORT ASSIGNMENT

1)	 Install to your PC the software driver for PC Configurator Cable or Infrared Communication Adaptor (‘cable’) appropriate 
for the connected hardware devices.  Refer to Users Manual for respective cables for detailed information on the installa-
tion procedure.

2)	 Connect the cable to your PC.

3)	 Choose the assigned COM port for each device.   

Connected Device Cable Type
SML COP-UM

SC100/200 series
COP-IRDA
COP-US

Note
COM port assignment may be changed when the cable is disconnected and connected again.  Confirm the COM port 
setting on your PC if there is communication error.
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3.4.4	 STORE/DELETE PORT ASSIGNMENT

Once the port assignment is stored, it cannot be deleted even disconnecting a communication adaptor cable.  Therefore it 
is available the usage connecting several cables to one USB port.  Select ‘Port setting delete” in ‘Operations’ menu to delete 
the port information.

3.5	 BASIC OPERATIONS

3.5.1	 CREATING & SAVING A PROJECT

The System Configuration view with an untitled project opens when you have started the SFEWin3E program on Start Menu.  
Start placing and setting modules to create a new project.

In order to modify an existing project, go to File > Open on the menu bar to specify the file to open.

Double-clicking on the project file on the desktop starts the program with the file opened on the System Configuration view.  
New setting and modification can be applied to it in this state.

A project file is NOT saved until you specifically operate to save it (no background backup file).  Save files periodically to 
protect your work.  If you try to exit without saving a current project, the program will prompt its saving.

Caution
Project files saved in the SFEW3E Ver.1.20 or later version formats cannot be read by an earlier version program.

3.5.2	 HELP DISPLAY

Function Block List

Go to Help > Function Block List to open a list of function blocks.  Click on the abbreviation code of a function block to show 
detailed information on it.

Version Information

Go to Help > Version Information to show the SFEWin3E’s version information.

Ladder Setting Shortcut Keys

Go to Help > Ladder setting shortcut key to show a list of shortcut keys available in Ladder Setting view.

Module Icons

Double-click module icons in the Module Window on the left in the System Configuration*, Communications Terminal Con-
nection, Function Block List and Analog Terminal Connection views to show Help information for each module function.

* �Eliminated from the SFEW3E with Ver. 1.100 or later 
For the detail,  refer to our web site.

3.5.3	 COPYING MODULES BETWEEN PROJECTS

Modules can be copied between two projects opened at once on the desktop.  You cannot start the SFEWin3E program twice 
with one project.

Caution
Copying operation may slow the PC’s operation depending on its performance capability.
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4.	 SYSTEM CONFIGURATION VIEW

4.1	 GENERAL DESCRIPTIONS

System Configuration view is used to place and set up device modules (‘cards’) to create a new project, to modify or delete 
projects, or to upload/download card information.

An untitled project opens when you have started the SFEW3E program on Start Menu.

(1)
(2)

(3)

(6)

(7)

(5)

(8)

(4)

Module Window Setting Window

4.2	 SCREEN COMPONENTS

No. ITEM FUNCTION
(1) Station button NOT USED
(2) Card button Shows device types available for card slots.

(3) Card icons
Device module icons.  Only the highest version of devices appears in the Module Win-
dow, but a lower version can be specified after a module has been placed.

(4) Station slots NOT USED
(5) Card slots Up to 16 cards can be assigned per station.

(6)
Communication Terminal Connection 
button

Opens Communication Terminal Connection view.

(7) Function Block List button Opens Function Block List view for the selected module.
(8) Close button Quits System Configuration view.
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4.3	 OPERATIONS

4.3.1	 PLACING DEVICES

Drag and drop a module icon from the Module Window on the left to a card slot in the Setting Window on the right.  Alterna-
tively double-click a blank slot and choose a module on “Model Selection” dialog box.

Station slots on the leftmost column in the Setting Window is NOT USED.

By placing SC200W or SC210W in System Configuration view, an expansion module is automatically placed next to the 
placed module (actual module).

SC200W/SC210W can be placed in any of the card No.0 to E slots when the slot and the slot next to it are blank.

OPERATION CONTENTS

Placing device
Card No.0 to E slots are available for placing a device.
The slot to which the actual module is to be placed and the slot next to it must be blank because the 
expansion module is automatically placed next to the actual module.

The expansion module cannot directly input/output to/from the field terminal but can input/output via the field terminal of 
SC200W/SC210W by using the communication terminal.

For details, refer to the instruction manual of SC200W or SC210W.

4.3.2	 OPERATING WITH CONTEXT MENU

Various shortcut operations are available by clicking the right mouse button over a card slot.  Available operations depend 
upon whether the slot is assigned or not.

BLANK CARD SLOT

Upload
Used to read card information from an actual device and upload it to the card slot.  Not 
usable when no device is connected.

Restore Card Used to restore a backup card information.

ASSIGNED CARD SLOT

Select Version Used to specify a lower version of the selected device.
Syncronize Version Used to communicate with a placed device and get its version information.
Function Block List Opens Function Block List view for the selected device.
Analog Terminal Connection Opens Analog Terminal Connection view for the selected device.
Sequential Control Setting Opens Sequential Control Block Setting view for the selected device.

Upload
Used to read card information from an actual device and upload it to the card slot.  Not 
usable when no device is connected.

Download
Used to write card information to the connected device.  Not usable when no device is 
connected.

Compare
Used to compare card information on the display with the one stored in a connected 
device.

Move Used to cut and transfer a card to another slot.  [Shortcut: Ctrl + x]
Copy Used to copy a card.  [Shortcut: Ctrl + c]
Paste Used to paste a copied or transferred card.  [Shortcut: Ctrl + v]
Change Device Used to change card type assigned on the slot.
Delete Device Used to delete a placed card.
Card bulk print Used to print all card information at once.
Card backup Used to create a backup card information file.
Restore Card Used to restore backup card information.

4.3.2.1	 SELECT VERSION

All available versions of the device are listed.  Choose one matching the connected device.

4.3.2.2	 SYNCRONIZE VERSION

The program communicates with a placed device, get its version information and overwrites with compatible data.  Proceed 
only after the initial setting and a device is connected.

Note
When you access version information on the SC100/200 device, version numbers for each component board are listed.  
The one referred to in the SFEW3E program is SC_MAIN version.
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4.3.2.3	 FUNCTION BLOCK LIST

Function Block List view for the selected device opens.

4.3.2.4	 ANALOG TERMINAL CONNECTION

Analog Terminal Connection view for the device module opens.

4.3.2.5	 SEQUENTIAL CONTROL BLOCK SETTING

Sequential Control Block Setting view for the selected device opens.

4.3.2.6	 UPLOAD

Card information is read from an actual device and uploaded to the card slot.  Proceed only after the initial setting and a 
device is connected.

Available to proceed with any device assignment to ‘system configuration view’.  

UPLOAD DIALOG BOX

Connection Port
Selectable when a blank card slot is specified.  Choose an appropriate COM port as-
signed for the device.

BLANK CARD SLOT

Example: Model SML-R3 is set with Station 00, Card No. 4 and connected via the COP-UM cable. 
1)	 Right-click Station 00/Card No. 4 slot in System Configuration view and choose Upload to open “Upload” dialog box.
2)	 Click Start.
3)	 The SML-R3 is placed at the card slot and its card information is uploaded.

ASSIGNED CARD SLOT

Example: Model SML-R3 is set with Station 00, Card No. 4 and COM port has been set up with Option setting.

1)	 Drag and drop the SML-R3 icon from the Module Window on the left to the Station 00/Card No. 4 slot.
2)	 Right-click Station 00/Card No. 4 slot and choose Upload to open “Upload” dialog box.
3)	 Click Start.
4)	 The SML-R3 card information is uploaded.

Note 1.  Device name and version
When a device information is updated to the SFEW3E System Configuration view, uploaded device name and its version 
number depend on whether a device was already placed or not.

When uploading to a blank card slot, the SFEW3E takes the device name and its version from the device.  Uploading is 
not possible if the device’s data does not correspond to that managed by the SFEW3E.  If the device name matches but 
the version number does not, the SFEW3E uploads the data as the latest version.

When uploading to an assigned card slot, the device’s own version number is disregarded.  The SFEW3E handles it as the 
latest version.  For example, if you try to upload from Ver. 0.09 device to a slot assigned with Ver.0.10 device, the SFEW3E 
uploads the data as Ver.0.10.  In this case, differences between the versions cannot be downloaded to the device later.

Note 2.  Troubleshooting in communication errors in uploading/downloading
1. 	COM port: Confirm that the COM Port matches the device type.  Refer to Section: 3.4.3 PORT ASSIGNMENT.  COM 

port assignment may be changed when the cable is disconnected and connected again.  Confirm also the COM port 
setting on your PC.

2.	 Configuration mode: The SC100/200 series must be set to the SFEW configuration mode on the device in order to 
communicate with the SFEW3E.  Confirm the setting in Engineering View > Configuration > 01: Config mode.

3.	 Cable driver software:  Confirm that the driver software appropriate for each cable is installed.

Note 3.
Uploading and downloading of SC200W/SC210W and the expansion module is done separately.

SC200W/SC210W and the expansion module are uploaded together when they are placed in the adjacent blank card 
slots. 

They can be uploaded to any of the card No. 0 to E slots if it is blank and the slot next to it is also blank.
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4.3.2.7	 DOWNLOAD

Card information is downloaded to the connected device.  Proceed only after the initial setting and a device is connected.

DOWNLOAD DIALOG BOX

Clear EEPROM and Download
Download is performed after the EEPROM is cleared.  Previous setting may not be 
deleted if the memory has not been erased.

Target Group Bank 0
Downloading only the specified function block group(s).  Not selectable after ‘Clear 
EEPROM and Download’ has been executed.

Target Group Bank 2 NOT USED
Connected Devices Configurable when both ‘SCxxxx (COP-IRDA)’ and ‘SCxxxx (COP-US)’ are installed.

4.3.2.8	 COMPARE

Card information on the SFEW3E is compared on the display with the one stored in a connected device.  Proceed only after 
the initial setting and a device is connected.

COMPARE DIALOG BOX
Target Group Comparing only the specified function block group(s).
Connected Devices Configurable when both ‘SCxxxx (COP-IRDA)’ and ‘SCxxxx (COP-US)’ are installed.

4.3.2.9	 MOVE

Command to transfer cards between slots.  Alternatively use a shortcut key combination: Ctrl + x.

SC200W/SC210W and the expansion module are moved together.

They can be moved to any of the card No. 0 to E slots if it is blank and the slot next to it is also blank.

4.3.2.10	COPY

Command to copy cards.  Alternatively use a shortcut key combination: Ctrl + c.

SC200W/SC210W are copied to adjacent blank slots together.

Only the selected card information is copied when the assigned card slot is overwritten.

4.3.2.11	PASTE

Command to paste copied or transferred cards.  Alternatively use a shortcut key combination: Ctrl + v.

4.3.2.12	CHANGE DEVICE

Command to change card type assigned to the slot without deleting its setting.

Caution
Settings assigned to the card slot are not deleted but certain part of the information may be lost.

4.3.2.13	DELETE DEVICE

Command to delete a placed card.

4.3.2.14	CARD BULK PRINT

Command to print all card information at once.

4.3.2.15	CARD BACKUP

Command to create a backup card information file (File extension: .BKC).

4.3.2.16	RESTORE CARD

Command to restore backup card information.

Right-clicking one of the backup files in Restore Card Information dialog box opens ‘Delete Backup Information’ dialog.
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5.	 COMMUNICATION TERMINAL CONNECTION VIEW

5.1	 GENERAL DESCRIPTION

Communication Terminal Connection view is used to set up and connect the communication terminals for the devices as-
signed in System Configuration view.

A device module is graphically represented as a rectangle box with square- and pentagon-shaped terminals located along 
its sides (‘module’). 

5.2	 SCREEN COMPONENTS

(2)

(1)

(3)

(7)

(11)

(8)

(12)

Module Window Setting Window

(6)

(5)

(4)

(9)

(10)

No. ITEM FUNCTION
(1) Card icons Device module icons.
(2) Card button Shows device types available for card slots.
(3) Communication Terminals button Shows communication terminal types.

(4) Module
Shows placed device modules on the Setting Window.   
Accompanied with Station / Card No. / Device model No. on it.

(5) Terminal

Terminal types are indicated with graphical symbols.
• Discrete input terminal
     Square shape placed inside of a module.
• Discrete output terminal
     Square shape place outside of a module.
• Analog input terminal
     Pentagon shape with an internal line.  Placed inside of a module.
• Analog output terminal
     Pentagon shape without an internal line.  Placed outside of a module.

(6)
Present value monitor
(online monitoring)

Selectable only with L-Bus connection, thus NOT USED.

(7) Wiring junction Connecting point of software wires.
(8) Wiring Connection of software wiring.
(9) Jump destination label Destination terminal is indicated without wiring line.
(10) Comment box Shows comments.
(11) System Configuration button Opens System Configuration view.
(12) Close button Closes Communication Terminal Connection view.

Note
Wirings are indicated in direct lines when a card information is uploaded for the first time.



22SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

5.3	 OPERATIONS

5.3.1	 PLACING DEVICES

Drag and drop a device module icon from the Module Window on the left to the Setting Window on the right.  “Device Layout” 
dialog box appears so that Station 00, Card No. and the device’s version No. are selected.  The smallest vacant slot number 
is provided as default.

A new device module added in Communication Terminal Connection view is placed automatically in System Configuration 
view.

A device module’s position can be freely moved by dragging the graphic with the mouse.  Multiple modules can be selected 
by holding Ctrl key.

Caution
Be sure not to place one module over another.  If two device modules are on top of each other, rubberband lines may 
extend from the terminals of the one at the bottom.

5.3.2	 PLACING COMMUNICATION TERMINALS

Drag a communication terminal module icon from the Module Window on the left to the Setting Window on the right and drop 
inside a device module.  Input terminals are placed along the outside of a module, while output terminals are along the inside 
of it.  An input terminal specified for ‘PC setting’ is yellow colored.

Once a communication terminal is placed, relevant function blocks are placed at once at Groups 11 to 26 on Function Block 
List and Analog Terminal Connection views.  Figures 11 to 26 indicated on the module mean these groups.

Communication Terminal Setting Function Block List

Analog Terminal Connection

Note
PC setting is valid only for L-Bus connection.  NOT USED.
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5.3.3	 FUNCTION BLOCK SETTING

Double-click a communication terminal placed on a device module to open Function Block Setting window and set up Item 
and Terminal information for each block.  Refer to Section: 6. FUNCTION BLOCK SETTING VIEW.

5.3.4	 TERMINAL WIRING

Click a communication terminal placed on a device module to show a rubberband line.  Only horizontal and vertical lines can 
be newly drawn but they can be adjusted to be diagonal later.

Start point Either an input terminal or an output terminal could be the point to start drawing.
Breakpoint At the maximum of 30 points

Cancel while drawing
Right-click or press Esc key to cancel the most previously drawn point.  Lines can be 
deleted by continuing the mouse/key operation.

Terminals available to be connected

Connect an analog terminal to another analog terminal, a discrete terminal to another 
discrete terminal.
Basic connection is configured between an input terminal to an output terminal, how-
ever, an already connected input terminal can be re-connected to another input terminal, 
so that the first one is set for re-transmission use (ITEM 19).

1 to N connection Single output terminal can be connected to multiple input terminals.
Adding destination terminal Destination terminal can be specified without drawing a line.
Selecting wiring Click on a line to modify it.

Modifying wiring
Select a line and right-click to use a context menu to change line type/thickness, color 
and other properties.

Deleting wiring Select a line and press Del key to delete it.

Caution
1.	 When an input terminal connected to an output terminal is also connected to another input terminal for re-transmission, 

wiring between these input terminals is left even when the wiring between the input and output terminals is deleted.  
Be sure to delete it manually.

2.	 If an input terminal connected to an output terminal is connected to another input terminal with PC setting for re-trans-
mission, the original connection between the input and output terminals is deleted.

5.3.5	 ENTERING COMMENTS

Comments can be added on the graphic drawing board.

Choose Comment on the tool bar and enter a comment in Comment dialog box.  A comment box can be freely moved by 
dragging the inside of it and re-sized by dragging on the side lines.

5.3.6	 PRINTING

The view is printed at the current zoomed display size when Print command is chosen at the tool bar.

When you choose File > Print on the menu bar, the whole drawing area is printed at a specified scale in single page.

In either case, the program automatically detects all components’ positions and adjust the printed area to cover all of them.
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5.3.7	 OPERATING WITH CONTEXT MENU

Various shortcut operations are available by clicking the right mouse button over the graphic drawing area.  Available opera-
tions depend upon whether you have right-clicked over a graphic or empty area.

RIGHT-CLICKING AN EMPTY AREA

Connection line format Used to specify/change line type, thickness and color.

Upload
Used to read card information from an actual device for uploading.  Not usable when no 
device is connected.

Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING A DEVICE MODULE

Connection line format Used to specify/change line type, thickness and color.

Upload
Used to read card information from an actual device for uploading.  Not usable when no 
device is connected.

Download
Used to write card information to the connected device.  Not usable when no device is 
connected.

Delete Device Used to delete a placed device module.

Help
Opens Help window for the device.*
* �Eliminated from the SFEW3E with Ver. 1.100 or later 

For the detail,  refer to our web site.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING AN INPUT TERMINAL

PC setting (NOT USED)
Used to specify the terminal for re-transmission to receive input signal from a PC.  Us-
able with the one not specified for a PC use.

Disconnect PC (NOT USED)
Used to cancel the re-transmission function of the terminal.  Usable with the one speci-
fied for a PC use.

Connection line format Used to specify/change line type, thickness and color.
Add jump destination Connecting terminal can be specified without drawing a line.
Select connection line Used to select a wire connected to the terminal.
Delete connection line Used to delete a wire connected to the terminal.
Delete Terminal Used to delete the input terminal.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING AN OUTPUT TERMINAL

Connection line format Used to specify/change line type, thickness and color.
Add jump destination Connecting terminal can be specified without drawing a line.
Delete Terminal Used to delete the output terminal.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING A SELECTED WIRING

Connection line format Used to specify/change line type, thickness and color.
Add Breakpoint Used to add a breakpoint on the line.
Delete Breakpoint Used to delete a breakpoint on the line.
Delete connection line Used to delete a wire.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.
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5.3.7.1	 CONNECTION LINE FORMAT

Line type, thickness and color can be changed.

5.3.7.2	 UPLOAD

Card information is read from an actual device and uploaded to the graphic drawing board.  Proceed only after the initial set-
ting and a device is connected.

Available to proceed with any device assignment to ‘Communication terminal connection’ view.  

UPLOAD DIALOG BOX

Connected Devices
Selectable when the right mouse button is clicked over an empty graphic area.  Choose 
an appropriate device for uploading.

Uploading is usable regardless of the device layout in System Configuration view.

EMPTY AREA

Example: Model SML-R3 is set with Station 00, Card No. 4 and connected via the COP-UM cable. 
1)	 Right-click Station 00/Card No. 4 slot in System Configuration view and choose Upload to open “Upload” dialog box.
2)	 Click Start.
3)	 The SML-R3 is placed at the card slot and its card information is uploaded.

PLACED DEVICE MODULE

Example: Model SML-R3 is set with Station 00, Card No. 4 and COM port has been set up with Option setting.

1)	 Drag and drop the SML-R3 icon from the Module Window on the left to the Station 00/Card No. 4 slot.
2)	 Right-click Station 00/Card No. 4 slot and choose Upload to open “Upload” dialog box.
3)	 Click Start.
4)	 The SML-R3 card information is uploaded.

5.3.7.3	 DOWNLOAD

Card information is downloaded to the connected device.  Proceed only after the initial setting and a device is connected.

DOWNLOAD DIALOG BOX

Clear EEPROM and Download
Download is performed after the EEPROM is cleared.  Previous setting may not be 
deleted if the memory has not been erased.

Target Group Bank 0
Downloading only the specified function block group(s).  Not selectable after ‘Clear 
EEPROM and Download’ has been executed.

Target Group Bank 2 NOT USED
Connected Devices Configurable when both ‘SCxxxx (COP-IRDA)’ and ‘SCxxxx (COP-US)’ are installed.

5.3.7.4	 DELETE DEVICE

Selected device module is deleted.

5.3.7.5	 HELP

Help window opens.*

* �Eliminated from the SFEW3E with Ver. 1.100 or later 
For the detail,  refer to our web site.

5.3.7.6	 DRAW JUNCTION POINT

A black circular point ( • ) indicating a wire junction is drawn.

5.3.7.7	 PC SETTING (NOT USED)

This command is used for connecting operation by a PC.  The input terminal is specified for re-transmission (ITEM 19 = 1) to 
receive input signal from a PC (ITEM 11 = FE).  Both analog and discrete input terminals specified for PC setting are marked 
with yellow color.

Usable with the terminal not specified for a PC use.

Caution
If PC setting is applied to an input terminal already wired, the connection line is deleted.
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5.3.7.8	 DISCONNECT PC (NOT USED)

PC setting for an input terminal is cancelled.  Usable with the one specified for a PC use.

5.3.7.9	 ADD JUMP DESTINATION

Wiring can be made without drawing a line by specifying a common reference (label) to the input and output terminals.

1)	 Right-click either input or output terminal and choose Add Jump Destination to open “Jump to Label” dialog box.
2)	 Enter an arbitrary label name.

3)	 Right-click the paired terminal and choose Add Jump Destination to open “Jump to Label” dialog box.
4)	 Enter the same label name.
5)	 Both terminals are now connected.

	
Use ‘Delete connection line’ command to delete the connection created in this way.

Caution
Too many characters entered for a label name may overlap other items.

5.3.7.10	SELECT CONNECTION LINE

This command is shown for a wired input terminal.  Choose it to select the entire sections of wiring connected to the terminal.  
You can also choose the connection line directly by clicking on one.

5.3.7.11	 DELETE CONNECTION LINE

This command is shown for a wired input terminal.  Choose it to delete the entire sections of wiring connected to the terminal.  
You can also choose the connection line and press Del key. 

5.3.7.12	DELETE TERMINAL

Command to delete input or output terminals.

Caution
A connecting line for a wired input terminal is deleted together with the terminal with the command, while that for a wired 
output terminal is not.  Delete the connecting line first and then the output terminal in this case.

The same principle is applied for those terminals with ‘Jump Destination’ setting.  Present value monitor remains when the 
output terminal is deleted.  Execute ‘Delete connection line’ at the paired input terminal.

5.3.7.13	RESET TO ORIGIN

The graphic drawing board shifts to the original coordinates (Left top coordinates: 0, 0).
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6.	 FUNCTION BLOCK SETTING VIEW

6.1	 GENERAL DESCRIPTION

Function Block Setting view is used to set up Item and Terminal information for each block by directly entering setting data in 
the table format.  Item Information and Terminal Information views are available.

Item Information

Terminal Information
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6.2	 HOW TO CALL UP FUNCTION BLOCK SETTING VIEW

ORIGIN POINT HOW TO CALL UP FUNCTION BLOCK SETTING VIEW
Communication Terminal Connection view Double-click an already placed input or output terminal.

Function Block List Setting view
Right-click an already placed function block and choose Function Block Setting.  Alterna-
tively, double-click the function block.

Analog Terminal Connection view Double-click an already placed function block.
Sequential Control Block Setting view Choose ‘Mnemonic’ from a context menu.

6.3	 OPERATIONS

6.3.1	 ENTERING SETTING DATA

Double-click one of the cells under ‘Setting Data’ column (Item Information) or ‘Comment’ column (Terminal Information) to 
directly enter values/texts.  Refer to ‘Valid setting range’ column for selectable range.

6.3.2	 PRINTING

Both Item Information and Terminal Information views are printed at once.
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7.	 FUNCTION BLOCK LIST VIEW

7.1	 GENERAL DESCRIPTION

Function Block List view is used to assign function blocks to a device placed in System Configuration view.

7.2	 SCREEN COMPONENTS

(2)

(1)

(3)

(4)

(6)

(7)

Module Window Setting Window

(5)

No. ITEM FUNCTION
(1) Function block module icons Function block icons.
(2) Group button Shows function blocks by sub categories.
(3) Function block slot Function blocks are assigned.
(4) System Configuration button Opens System Configuration view.
(5) Analog Terminal Connection button Opens Analog Terminal Connection view.

(6)
Sequential Control Block Setting 
button

Opens Sequential Control Block Setting view.

(7) Close button Quits System Configuration view.
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7.3	 OPERATIONS

7.3.1	 PLACING FUNCTION BLOCKS

Drag a function block module icon from the Module Window on the left to the Setting Window on the right and drop over a 
function block slot.  Alternatively, double-click a function block slot to open “Select Function” dialog box to choose one.

A function block can be placed only in the slots of the same group.

7.3.2	 OPERATING WITH CONTEXT MENU

BLANK FUNCTION BLOCK SLOT

Upload
Used to read card information from an actual device and upload it to the card slot.  Not 
usable when no device is connected.

ASSIGNED FUNCTION BLOCK SLOT
(Group 00: System common table, Group 01: Field terminal, Group 80: System’s internal switch)

Function Block Setting Opens Function Block Setting view for the assigned function.

Upload
Used to read card information from an actual device and upload it to the card slot.  Not 
usable when no device is connected.

Download
Used to write card information to the connected device.  Only specified groups of data is 
downloaded.  Not usable when no device is connected.

Compare
Used to compare card information on the display with the one stored in a connected 
device.

ASSIGNED FUNCTION BLOCK SLOT (other groups)

Function Block Setting Opens Function Block Setting view for the assigned function.

Upload
Used to read card information from an actual device and upload it to the card slot.  Not 
usable when no device is connected.

Download
Used to write card information to the connected device.  Only specified groups of data is 
downloaded.  Not usable when no device is connected.

Compare
Used to compare card information on the display with the one stored in a connected 
device.

Move Used to cut and paste a function block to another slot.  [Shortcut: Ctrl + x]
Copy Used to copy a function block.  [Shortcut: Ctrl + c]
Paste Used to paste a copied or cut function block.  [Shortcut: Ctrl + v]
Change Function Used to change function block type assigned to the slot.
Delete Function Used to delete a function block.
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7.3.2.1	 FUNCTION BLOCK SETTING

Function Block Setting view for the selected function block opens.

7.3.2.2	 UPLOAD

Information on function blocks per group is read from an actual device and uploaded to SFEW3E.  First, configure param-
eters on “Option” dialog box for the device and connect to the device.  There is no need of setting “Connected Device” on the 
“Upload” dialog box as the program automatically refers to the “Option” setting.

Uploading is usable regardless of the function block layout in Function Block Setting view.

No setting is uploaded if the requested group of function blocks is not assigned to the device.

BLANK FUNCTION BLOCK SLOT

Example: Model SML-R3 is set with Station 00, Card No. 4 and connected via the COP-UM cable. 
1)	 Right-click any function block in Function Block List view and choose Upload to open “Upload” dialog box.
2)	 Click Start.
3)	 The uploaded function block modules are placed in Function Block List view and function block information is written to 

Function Block Setting.

ASSIGNED FUNCTION BLOCK SLOT

Example: Model SML-R3 is set with Station 00, Card No. 4 and COM port has been set up with Option setting. 
1)	 Drag and drop any function block module icon from the Module Window on the left to a function block slot.
2)	 Right-click the placed function block and choose Upload to open “Upload” dialog box.
3)	 Click Start.
4)	 The uploaded function block information is written to Function Block Setting.

7.3.2.3	 DOWNLOAD

Information on function blocks of the selected group is downloaded from SFEW3E to a connected device.  First, configure 
parameters on “Option” dialog box for the device and connect to the device.

7.3.2.4	 COMPARE

Information on function blocks of the selected group on the SFEW3E is compared with the one stored in a connected device.  
First, configure parameters on “Option” dialog box for the device and connect to the device.

7.3.2.5	 MOVE

Command to transfer function blocks between slots.  Alternatively use a shortcut key combination: Ctrl + x.

7.3.2.6	 COPY

Command to copy function blocks.  Alternatively use a shortcut key combination: Ctrl + c.

7.3.2.7	 PASTE

Command to paste copied or transferred function blocks.  Alternatively use a shortcut key combination: Ctrl + v.

Caution
Move - Copy - Paste commands are valid only within the same function block group.

7.3.2.8	 CHANGE FUNCTION

Command to change function block type assigned on the slot.

7.3.2.9	 DELETE FUNCTION

Command to delete a placed function block.
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8.	 ANALOG TERMINAL CONNECTION VIEW

8.1	 GENERAL DESCRIPTION

Analog Terminal Connection view is used to set up and connect the analog terminals for each device placed in System 
Configuration view.

Setting Window shows analog function blocks assigned to each device.

A function block module is graphically represented as a rectangle box with square- and pentagon-shaped terminals located 
along its sides. 

8.2	 SCREEN COMPONENTS

(1)

(2)

(3)

(10)

(9)

(11)

Module Window Setting Window

(5)
(4)
(7)

(6)

(8)

No. ITEM FUNCTION
(1) Function block module icons Function block icons.
(2) Group button Shows function blocks by sub categories.

(3) Function block module
Shows placed function blocks on the Setting Window.   
Accompanied with Group No. / Abbreviation code / Function block description on it.

(4) Terminal

Terminal types are indicated with graphical symbols.
• Analog input terminal
     Pentagon shape with an internal line.  Placed inside of a module.
• Analog output terminal
     Pentagon shape without an internal line.  Placed outside of a module.

(5)
Present value monitor
(online monitoring)

Shows current value of the terminal during online monitoring.

(6) Wiring junction Connecting point of software wires.
(7) Wiring Connection of software wiring.
(8) Jump destination label Destination terminal is indicated without wiring line.
(9) Comment box Shows comments.
(10) Function Block List button Opens Function Block List view.
(11) Close button Closes Analog Terminal Connection view.

Note
Wirings are indicated in direct lines when a card information is uploaded for the first time.
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8.3	 OPERATIONS

8.3.1	 PLACING FUNCTION BLOCKS

Drag a function block module icon from the Module Window on the left to the Setting Window on the right and drop over an 
empty space.  “Select Group” dialog box appears so as to specify to which group the function block should be assigned.  The 
smallest vacant group number is provided as default.

A new function block module added in Analog Terminal Connection view is placed automatically among the same group in 
Function Block List view.

A function block module’s position can be freely moved by dragging the module with the mouse.  Multiple modules can be 
selected by holding Ctrl key.

Caution
• �Be sure not to place one module over another.   

If two function block modules are on top of each other, rubberband lines may extend from the terminals of the one at 
the bottom.

• �When the magnification level is changed from full-screen to 25% on a PC, some of function block modules, especially 
ones placed at the right end of the Setting Window, may not be manipulated with a mouse.  In such a case, click to 
select the left end of the function block module and drag to the left. 

• �To select and drag multiple function block modules to the right end of the Setting Window, drag them inch by inch 
instead of moving them with one drag, otherwise they may be unselected in the middle of dragging. 

• �When a function block module is overlapped with wirings at the end of the Setting Window and is difficult to select, in-
crease the magnification level and try again. 

8.3.2	 FUNCTION BLOCK SETTING

Double-click a function block module to open Function Block Setting window and set up Item and Terminal information for the 
function block.  Refer to Section: 6. FUNCTION BLOCK SETTING VIEW.

8.3.3	 TERMINAL WIRING

Click an analog terminal placed on a function block module to show a rubberband line.  Only horizontal and vertical lines can 
be newly drawn but they can be adjusted to be diagonal later.

Start point Either an input terminal or an output terminal could be the point to start drawing.
Breakpoint At the maximum of 30 points

Cancel while drawing
Right-click or press Esc key to cancel the most previously drawn point.  Lines can be 
deleted by continuing the mouse/key operation.

1 to N connection Single output terminal can be connected to multiple input terminals.
Adding destination terminal Destination terminal can be specified without drawing a line.
Selecting wiring Click on a line to modifying it.

Modifying wiring
Select a line and right-click to use a context menu to change line type/thickness, color 
and other properties.

Deleting wiring Select a line and press Del key to delete it.

8.3.4	 ENTERING COMMENTS

Comments can be added on the graphic drawing board.

Choose Comment on the tool bar and enter a comment in Comment dialog box.  A comment box can be freely moved by 
dragging the inside of it and re-sized by dragging on the side lines.

8.3.5	 PRINTING

The view is printed at the current zoomed display size when Print command is chosen at the tool bar.

When you choose File > Print on the menu bar, the whole drawing area is printed at a specified scale in single page.

In either case, the program automatically detects all components’ positions and adjust the printed area to cover all of them.
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8.3.6	 OPERATING WITH CONTEXT MENU

Various shortcut operations are available by clicking the right mouse button over the graphic drawing area.

Available operations depend upon whether you have right-clicked over a graphic or empty area.

RIGHT-CLICKING AN EMPTY AREA

Connection line format Used to specify/change line type, thickness and color.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING A FUNCTION BLOCK MODULE

Delete Function Used to delete a placed function block module.
Help Opens Help window for the device.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING AN INPUT TERMINAL

Connection line format Used to specify/change line type, thickness and color.
Add jump destination Connecting terminal can be specified without drawing a line.
Select connection line Used to select a wire connected to the terminal.
Delete connection line Used to delete a wire connected to the terminal.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING AN OUTPUT TERMINAL

Connection line format Used to specify/change line type, thickness and color.
Add jump destination Connecting terminal can be specified without drawing a line.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

RIGHT-CLICKING A SELECTED WIRING

Connection line format Used to specify/change line type, thickness and color.
Add Breakpoint Used to add a breakpoint on the line.
Delete Breakpoint Used to delete a breakpoint on the line.
Delete connection line Used to delete a wire.
Draw Junction Point Used to draw a black circular point.
Reset to Origin Used to shift to the original point of the graphic drawing board.

8.3.6.1	 CONNECTION LINE FORMAT

Line type, thickness and color can be changed.

8.3.6.2	 DELETE FUNCTION

Selected function block module is deleted.

8.3.6.3	 HELP

Help window opens.

8.3.6.4	 DRAW JUNCTION POINT

A black circular point ( • ) indicating a wire junction is drawn.
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8.3.6.5	 ADD JUMP DESTINATION

Wiring can be made without drawing a line by specifying a common reference (label) to the input and output terminals.

1)	 Right-click either input or output terminal and choose Add Jump Destination to open “Jump to Label” dialog box.
2)	 Enter an arbitrary label name.
	

3)	 Right-click the paired terminal and choose Add Jump Destination to open “Jump to Label” dialog box.
4)	 Enter the same label name.
5)	 Both terminals are now connected.
	

Use ‘Delete connection line’ command to delete the connection created in this way.

Caution
Too many characters entered for a label name may overlap other items.

8.3.6.6	 SELECT CONNECTION LINE

This command is shown for a wired input terminal.  Choose it to select the entire sections of wiring connected to the terminal.  
You can also choose the connection line directly by clicking on one.

8.3.6.7	 DELETE CONNECTION LINE

This command is shown for a wired input terminal.  Choose it to delete the entire sections of wiring connected to the terminal.  
You can also choose the connection line and press Del key.  The setting data of connection terminal for the input terminal 
shows ‘0099’ when the delete is complete.

8.3.6.8	 RESET TO ORIGIN

The graphic drawing board shifts to the original coordinates (Left top coordinates: 0, 0).
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9.	 SEQUENTIAL CONTROL BLOCK SETTING VIEW

9.1	 GENERAL DESCRIPTION

Sequential Control Block Setting view is used to enable/disable the sequential control blocks assigned in Function Block List 
view.

9.2	 SCREEN COMPONENTS

(1)

(2)

(3)

(4)

(5)

No. ITEM FUNCTION
(1) Group button Buttons indicating valid groups.

(2) Step button
Buttons placed when Step commands are set.  Branch commands are indicated with con-
necting lines to show jump destinations.

(3) Function Block List button Opens Function Block List view.
(4) Ladder Setting button Opens Ladder Setting view.
(5) Close button Closes Sequential Control Block Setting view.

Connecting lines between Step buttons appear when Group or Step buttons are clicked to show jump destinations for Branch 
commands relevant to the group or the step.
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9.3	 OPERATIONS

9.3.1	 ENABLING SEQUENTIAL CONTROL BLOCK

Sequential Control Blocks are assigned to Groups 81 through 92 in Sequential Control Block Setting view, which are placed 
in Function Block List view as valid groups.  Double-click one of these groups to open Ladder Setting view.  Alternatively, click 
the button and then Ladder Setting button.

An invalid group can be turned to valid one by right-clicking the group button and choose Enable Setting.  A sequential control 
block is automatically assigned to the relevant group in Function Block List view.

9.3.2	 OPERATING WITH CONTEXT MENU

Various shortcut operations are available by clicking the right mouse button on the Group and Step buttons.  Available opera-
tions depend upon whether you have right-clicked over a drawing or empty area.

RIGHT-CLICKING AN INVALID GROUP BUTTON

Enable Setting Used to enable the group.

RIGHT-CLICKING A VALID GROUP BUTTON

Ladder Opens Ladder Setting view.
Mnemonic Opens Function Block Setting view.
Disable Setting Used to disable the group.

RIGHT-CLICKING A STEP BUTTON

Ladder Opens Ladder Setting view.
Mnemonic Opens Function Block Setting view.

9.3.2.1	 ENABLE SETTING

Command to enable the selected group.  Step 00 is automatically created.

Caution
When Group 81 is invalid, other groups cannot be enabled.

9.3.2.2	 DISABLE SETTING

Command to disable the selected group.

Caution
When Group 81 is disabled, all other groups are also disabled.

9.3.2.3	 LADDER

Command to open Ladder Setting view for the selected group or step.

9.3.2.4	 MNEMONIC

Command to open Function Block Setting view for the selected group or step.
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10.	 LADDER SETTING VIEW

10.1	 GENERAL DESCRIPTION

Ladder Setting view is used to program a sequential control block using ladder sequence diagrams.  Applicable to the groups 
enabled in Sequential Control Block Setting view.

10.2	 SCREEN COMPONENTS

(1)

(2)

(3)

(5)

(7)

(4)

(6)

Module Window Setting Window

No. ITEM FUNCTION
(1) Ladder command module icons Ladder command icons.

(2) Ladder command diagram

Ladder commands consist of the following components:
• Group No. + Terminal No.
• Command symbol
• Comment (Terminal description set in Function Block Setting view, max. 20 characters)

(3)
Sequential Control Block Setting 
button

Opens Sequential Control Block Setting view.

(4) Confirm button Used to check validity of the input data.  Error messages are displayed for errors.

(5)
Show Comment / Hide Comment 
button

Used to switch the view to show or hide comments.

(6) Cancel button Closes Ladder Setting view without saving modified input data.
(7) Close button Closes Ladder Setting view.
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10.3	 OPERATIONS

10.3.1	 CREATING LADDER COMMANDS

Three methods are available to create ladder commands

• Drag & drop module icons
	 Drag a Command icon from the Module Window on the left and drop them in the Setting Window on the right to place a 

command. 

• Shortcut keys
	 Click any point on the Setting Window to show a cursor and enter shortcut key combinations on the keyboard to place a 

command.

	 Help menu is available to refer to the list of shortcut key combinations.

• Context menu
	 Right-click any point of the Setting Window to show a context menu and choose a command to be placed.

10.3.2	 COMMANDS

Step

Step Number Enter a Step Number between 00 and 19.

Timer

Timer Type Choose 0: On Delay Timer or 1: Step Monitor Timer.
Set Time Enter between 0 and 999 seconds.

N.O. and N.C. Contact

Contact Input
Specify Group and Terminal numbers (GGNN).  Alternatively click Browse button to open 
Select Contact window to choose from Group and Contact lists.

Output Coil, Output (NOT), SET Coil, RESET Coil, One Shot Coil

Coil Input
Specify Group and Terminal numbers (GGNN).  Alternatively click Browse button to open 
Select Contact window to choose from Group and Contact lists.

Branch

Input Jump
Specify Group and Step numbers (GGSS).  Branch command is set to its own group 
when Group 00 is specified.

Connection
Command to create a connection line.

Delete
Command to delete a ladder command.

OR connection (DEL)
Command to create a OR connection line.  A vertical line is drawn at the left top of the cursor position.  OR connection line is 
deleted when the command is selected over the cursor position where the connection line is created.

Insert Row
Command to create a blank row at the top of the cursor position.

Delete Row
Command to delete a row at the cursor position.

Enter Comment
Command to modify a terminal description set in Function Block Setting view.  Available when the cursor is positioned over 
a contact with ‘Show Comment’ setting.

Move, Copy, Paste
Command to move [Ctrl + x], copy [Ctrl + c] and paste [Ctrl + v] a command.
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10.3.3	 CONFIRMING LADDERS & ERROR MESSAGES

Click Confirm button to check validity of the input data.  Error messages are displayed when there is an error.

ERROR MESSAGES

MESSAGE EXPLANATIONS & WHAT TO DO
Connection is not completed. Connect unfinished sections.

Item number overflow.
More than 89 commands (ITEM 01 through 99) have been en-
tered.  Delete unused commands or separate a section of the 
commands to a new Group.

Cannot translate.
An undefined pattern has been created.  Modify it to a correct 
pattern.

First element is invalid.
Invalid command is at the start position of the row.  Correct the 
element.

Contact is not allowed with branching from a coil.
Branching with a contact from a coil is not available.  Correct the 
branching section of the ladder.

Contact is not allowed in the middle of a row if the first element is other 
than contact.

A row which does not have a contact at the start position cannot 
contain a contact.

OR connection is not allowed if the first element is other than contact.
A row which does not have a contact at the start position can-
not have OR connection.  Set a contact at the start position or 
cancel OR connection.

Specify output instruction in coil if the first element is other than contact.
A row which does not have a contact at the start position must 
have an output command at the coil.

Connection is invalid if the first element is other than contact. 
Invalid connection if the start position does not have a contact.  
Set a contact at the start position or cancel invalid connection.

A new command has been created before STEP command. A command has been inserted before STEP command.
Incorrect STEP number. Invalid STEP number.  Choose between 00 and 19.

Duplicate STEP number.
Duplicate STEP numbers.  Using same STEP numbers in one 
group is not allowed.

OR connection in STEP command is not allowed. 
OR connection cannot be made to STEP command.  Delete the 
OR connection.

Contact is not allowed in STEP command. A contact is in STEP command row.  Move to a next row.

Output is not allowed in STEP command.
An output command is in STEP command rung.  Move to a 
next row.

Timer is not allowed in STEP00. Timer cannot be used in STEP00.
OR connection to a timer is not allowed. OR connection cannot be made to Timer command.
Contact is not allowed in Timer command. Contact cannot be specified in Timer command.
Output is not allowed in Timer command. Output cannot be specified in Timer command.

Specify output in STEP00.
STEP00 must have an output.  STEP01 and following STEPs 
can be defined without output.

Branching to STEP00 is not allowed. Branching to STEP00 is not allowed.
Branching from STEP00 is not allowed. Branching from STEP00 is not allowed.
STEP00 or STEP01 does not exist. STEP00 or STEP01 cannot be deleted.

STEP02 or following steps are not allowed without STEP01 defined.
STEP02 and following STEPs cannot be defined without 
STEP01.

Ladder without output is valid only immediately before STEP or END 
commands.

Only the last row of a STEP can be without an output command.

Error in sequence connection. The specified terminal number does not exist.
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10.3.4	 HELP

Go to Help > Ladder Setting Shortcut Keys on the menu to open Ladder Operation Key Explanation window.  Alternatively, 
press Home key on the keyboard.
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11.	 ONLINE MONITORING

11.1	 GENERAL DESCRIPTION

Present values/status at the function block terminals of the device connected to the SFEW3E can be monitored.  Online 
monitoring is available in Analog Terminal Connection view and Ladder Setting view.

Values on the screen are not applied when printing the view.

Click Online Monitor icon in the tool bar to start/stop online monitoring.  Alternatively, choose Operation > Online Monitor.  The 
operation is applied also when starting monitoring in the Registry Monitor.

The Online Monitor icon in the tool bar blinks while the monitoring is continued.  You cannot operate or change settings of the 
view nor open the PU-2 Simulation view in the monitoring mode.

Online Monitor and Registry Monitor functions cannot be used at once.  Neither function can be used at once with the PU-2 
Simulation function.

Caution
Acquiring necessary data for online monitoring takes a certain time when the monitoring is started or when the view is 
switched.  Values/status may not be updated immediately.
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11.2	 ANALOG TERMINAL CONNECTION VIEW

Present values are indicated at the right side of the input/output connections.  Values on the screen are not applied when 
printing the view.

11.3	 LADDER SETTING VIEW

Present status of the sequence program is indicated with green lines on the screen.  The status on the screen is not applied 
when printing the view.

The displayed status may be a transient status depending on the control cycle of the connected device.
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11.4	 REGISTRY MONITOR VIEW

Specific ITEM or Terminals can be listed for monitoring of the connected device.

(1)

(2)

(3)

(9)

(7)

(8)

(4)
(5)

(10)(7)

Specify Station 00 and Card No. of the connected device, and enter Group & Terminal No. in GGNN fields, Group No. and 
Item No. in GGII fields.  If both fields are filled, GGNN prevails.

‘Out of range’ message is indicated in Data field for a GGII value of 8100 or greater, which should be monitored in Ladder 
Setting view.

Use Del key on the keyboard to delete an ITEM or a Terminal registered in the window.

No. ITEM FUNCTION
(1) Station Specify Station 00.
(2) Card Specify Card No. of the device to be monitored.
(3) GGNN Enter Terminal No.  GG = Group No.  NN = Terminal No.
(4) GGII Enter ITEM No.  GG = Group No.  II = ITEM No.
(5) Data Shows monitored values.
(6) ON/OFF Used to enable or disable to monitor the item.
(7) End button Closes Registry Monitor window.
(8) Start Monitor button Starts monitoring.  Replaced with ‘Stop Monitor’ while monitoring is continuing.
(9) Set All ON button Used to enable all registered items.
(10) Set All OFF button Used to disable all registered items.



45SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

12.	 PU-2 SIMULATION VIEW

12.1	 GENERAL DESCRIPTION

The PU-2A Programming Unit (hand-held programmer) is simulated on the screen to program function blocks.

The view is accessible from any other view while automatically referring to the COM port setting applied during initial setting.  
However, there are slight differences in operation depending upon the last action applied in the view as explained in the table 
below:

VIEW STATUS OPERATION

System Configuration
Device selected

The COM port setting for the device applied during initial setting is auto-
matically selected.

Device Not selected
“Select Connection Device” dialog appears to specify the device.  After 
that, previous connected device is automatically connected.

Communication Terminal Connection
Device selected

The COM port setting for the device applied during initial setting is auto-
matically selected.

Device Not selected
“Select Connection Device” dialog appears to specify the device.  After 
that, previous connected device is automatically connected.

Function Block List

--- “Select Connection Device” dialog appears to specify the COM port.
Analog Terminal Connection
Sequential Control Block Setting
Ladder Setting

Caution
Do not perform ‘Upload’, ‘Download’ or ‘Compare’ while PU-2 view is open, it might cause disconnection.  In such a case, 
close PU-2 or switchover ‘Connected devices’.  



46SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

12.2	 SCREEN COMPONENTS

(14)

(12)

(13)

(15)(17)

(3)

(4)

(2)

(1)

(8)

(7)

(6)

(5)

(11)

(9)

(10)

(16)

No. PU-2 KEY FUNCTION KEYBOARD SHORTCUT
(1) GROUP Click GROUP key and specify Group No. G (except for entering [DATA])
(2) ITEM Click ITEM key and specify ITEM No. I (except for entering [DATA])
(3) DATA Click DATA key and specify DATA No. D (except for entering [DATA])
(4) #  Numbers  .  - Used to enter #, numbers, . (period) or - (dash). #  Numbers  .  -
(5) CLR Used to delete a data entry. Delete key
(6) UP Used to go forward in ITEM or DATA numbers. ↑
(7) DOWN Used to go back in ITEM or DATA numbers. ↓
(8) ENTER Used to apply a data entry. Enter key
(9) GROUP UP Used to go forward in GROUP numbers. →
(10) GROUP DOWN Used to go back in GROUP numbers. ←
(11) BS Used to delete the last entered character while data entering. Back space key
(12) Alphabets Used to enter alphabets. Alphabets
(13) SML Transfer rate is set to 1200 bps. ---
(14) RTU Transfer rate is set to 9600 bps. (NOT USED) ---
(15) SCxxxxIRDA Transfer rate is set to 57600 bps. ---
(16) SCxxxxUS Transfer rate is set to 57600 bps. ---
(17) ABH2 Infrared communication (NOT USED) ---
(18) END Closes PU-2 Simulation view. ---

12.3	 CONNECTING WITH DEVICES

Transfer rate during monitoring depends upon the model.

Connected Device Cable Type Transfer Rate
SML COP-UM 1200 bps
SC100

COP-IRDA
COP-US

57600 bps
SC200
SC110
SC210
SC200D

COP-US 57600 bpsSC200W
SC210W
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13.	 APPLICATION EXAMPLE WITH SC100 CONTROLLER

13.1	 CONNECTING THE CONTROLLER TO PC

Connect the Controller to PC in order to communicate with the SFEW3E.

13.1.1	 INFRARED COMMUNICATION TYPE

1)	 Install the SFEW3E program and driver for Infrared Communication Adaptor device (model: COP-IRDA) to the PC and 
connect the COP-IRDA to its USB port.

2)	 Start up the SFEW3E and set the COM port number assigned to the USB in the initial setting.
3)	 Set the infrared port in the direct line to face the COP-IRDA’s send/receive window, within the maximum distance of 0.2 

meter.
4)	 Go to Engineering View and choose Configuration > 01 : Config mode > 02 : SFEW.  The front monitoring LED starts 

blinking slowly to indicate the ready state.  Refer to the Users Manual for the Controller for detailed operations.

PC
SFEW3E

Controller

COP-IRDA

USB portInfrared port
Max. 0.2 m

N144 (two-part type) Holder L Type Holder

Using Holders

Caution
1.	 Only one Controller module can communicate with the SFEW3E when multiple modules are mounted side by side.  

Detecting more than one module at once in the communication mode will result in error.
2.	 The Controller may not be able to establish normal communication in an environment present with noise from inverters.

13.1.2	 STEREO JACK TYPE

1)	 Install the SFEW3E program and driver for PC Configurator cable (model: COP-US) to the PC and connect the COP-US 
to its USB port.

2)	 Start up the SFEW3E and set the COM port number assigned to the USB in the initial setting.
3)	 Connect the COP-US to the connector adaptor and after this, to the Controller’s jack port.
4)	 Go to Engineering View and choose Configuration > 01 : Config mode > 02 : SFEW.  The front monitoring LED starts 

blinking slowly to indicate the ready state.  Refer to the USERS MANUAL of SC100/200 Series to operate the Controller.

PC
SFEW3E

Controller

COP-US
USB portStereo jack

Connector
adapter
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13.2	 APPLICATION EXAMPLE

The figure below shows an application example of PID control functions.

1)	 Setpoint (SP) and measured value (PV) are supplied as analog input signals from the exterior terminals (SP is connected 
to Ai Input Terminal).

2)	 They are provided to the basic PID control block and the manipulated value (MV), processed result of the function block, 
is output as an analog signal.

3)	 AUTO (auto) momentary switch, MAN (manual) momentary switch, CAS (cascade) momentary switch and LOC (local) 
momentary switch are supplied as discrete input signals.

4)	 High/Low limit alarm trips for PV value are provided to discrete output signals and indicated with alarm lamps.
The setting procedure is explained in the following sub sections.
Auto/Man switching and Cas/Loc switching operations are available at the front control buttons and by the touch panel opera-
tions of the Controller.

PID control is performed using the SP value provided from the exterior terminals during Cascade control mode, while it is 
using that is saved in the internal memory of the Controller during Local control mode.
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13.3	 PLACING THE DEVICE

Start up the SFEW3E program.  A blank System Configuration view is displayed.

Drag the SC100 icon from the Module Window on the left and drop it at Station 00, Card No. 0 slot in the Setting Window on 
the right.

Alternatively, double-click the Station 00/Card No. 0 slot to open “Model Selection” dialog to specify the model and version 
numbers.

13.4	 ASSIGNING PID CONTROL BLOCK

Double-click the placed SC100 icon in System Configuration view to open Function Block List view.

Control function blocks can be assigned to Groups 02 and 03.  Click Control [G02-03] group button in the left window and 
drag BCA 21 function block icon and drop it at G02 slot in the right window.

Alternatively, double-click the G02 slot to open “Select Function” dialog to specify the Basic PID.
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13.5	 CONNECTING ANALOG TERMINALS

SP, PV and MV signals are to be connected. 

Click Analog Terminal Connection button in Function Block List view to open Analog Terminal Connection view.

Measured input (PV) is supplied to Basic PID block.  Connect PV1 analog output terminal (21) of G04 EX1 (12) SC100 Exten-
sion field terminal 1 module to PV input terminal of G02 BCA (21) Basic PID module.

Setpoint (SP) is supplied by external cascade connection to Basic PID block.  Connect Ai 1 analog output terminal (23) of 
G04 EX1 module to CAS input terminal of G02 BCA module.

Manipulated value (MV) is provided to SC100 Extension field terminal 1 block.  Connect MV analog output terminal (25) of 
G02 BCA module to MV1 input terminal of G04 EX1 module.
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13.6	 SETTING EXTENSION FIELD TERMINAL BLOCKS

Go back to Function Block List view and double-click G04 EX1 slot to open Function Block Setting view for the SC100 Exten-
sion field terminal 1.

First specify the measured input (Pv1) signal type.  Go to ITEM 36 and enter ‘3’ (1 to 5V) in Setting Data field.

Click OK button to close the view.

Next, double-click G05 EX2 slot to open Function Block Setting view for the SC100 Extension field terminal 2.

Enable discrete input signals.  Discrete status or pulse train input can be selected for each discrete input.  Specify as discrete 
input for four inputs.  Go to ITEM 31 and enter ‘00000’ in Setting Data field.

Click OK to close the view.

Next, double-click G01 F70 slot to open Function Block Setting view for the SC100 Field terminal.

In order to indicate high/low alarm for the PV input on the SC100 display, go to ITEM 43 and enter ‘L’ in Setting Data field and 
then go to ITEM 44 and enter ‘H’.

Go through other setting items if necessary.
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Relevant function blocks and ITEMS, and the setting examples are as shown below.

GROUP [01] SC100 FIELD TERMINAL     “▲” marked data modifiable in PROGRAM mode.
ITEM MDFY DATA INPUT SETTING CONTENTS

43 ▲ alphanumeric L1: L AL1 comment (max. 4 characters)
44 ▲ alphanumeric L2: H AL2 comment (max. 4 characters)

GROUP [04] EXTENSION TERMINAL 1     “▲” marked data modifiable in PROGRAM mode.
ITEM MDFY DATA INPUT SETTING CONTENTS

25 ▲ GGNN M1#: 0225 MV1 connection terminal (error if not connected)
     GG: Group No.     NN: terminal No.

26 ▲ GGNN M2#: 0099 MV2 connection terminal (error if not connected)
     GG: Group No.     NN: terminal No.

27 ▲ GGNN A1#: 0099 Ao1 connection terminal (error if not connected)
     GG: Group No.     NN: terminal No.

28 ▲ GGNN A2#: 0099 Ao2 connection terminal (error if not connected)
     GG: Group No.     NN: terminal No.

36 ▲ MM TP1: 3 Pv 1 input type
[MM: input type No.] 12: S 19: Pt100 (JIS ‘97, IEC)
0: -10-10 V   6: K 13: C 20: Pt100 (JIS ‘89)
1: -1-1 V   7: E 14: N 21: JPt100 (JIS ‘89)
2: 0-10 V   8: J 15: U 22: Pt50 (JIS ‘81)
3: 1-5 V   9: T 16: L 23: Ni100
4: 0-1 V 10: B 17: P 24: MS
5: 4-20 mA 11: R 18: PR 25: DS

(Set ITEM37...39 for Pv 1 input type 6...23)

GROUP [05] EXTENSION TERMINAL 2     “▲” marked data modifiable in PROGRAM mode.
ITEM MDFY DATA INPUT SETTING CONTENTS

31 ▲ NNNNN PD: 00000 Di/Pi selection (0 = Di, 1 = Pi)

    N N N N N

Di 1 / Pi 1

Di 2 / Pi 2

Di 3 / Pi 3

Di 4 / Pi 4

Di 5 / Pi 5



53SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

13.7	 SETTING PID CONTROL BLOCK

Detailed parameters regarding the Basic PID is set in Function Block Setting view.

Go back to Function Block List view and double-click G02 BCA slot to open the Function Block Setting view.

In order to use an external SP value provided to the CAS terminal to control the PID, go to ITEM 29 and enter ‘1’ (Cascade/
Local).

For the control direction (ITEM 40), enter ‘1’ to decrease MV output or ‘0’ to increase it when PV input is greater than SP.  It 
is set to ‘1’ in normal use.

For P, I and D parameters, go to ITEM 42 (proportional band, 0 to 1000%), ITEM 43 (integral time, 0.00 to 100.00 minutes) 
and ITEM 44 (derivative time, 0.00 to 10.00 minutes).

In addition, set ITEM 19 for high alarm setpoint and ITEM 20 for low alarm setpoint (-15.00 to 115.00%) to provide limit alarm 
trips to discrete outputs.

Go through other setting items if necessary.
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13.8	 SETTING SEQUENTIAL CONTROL BLOCK

Discrete signals are managed on Sequential Control Blocks.

Click Sequential Control Block Setting button in Function Block List view to open Sequential Control Block Setting view.

Right-click Group 81 slot and choose Enable Setting, then Step00 slot appears below Group 81 slot.  Double-click the Step00 
slot to open Ladder Setting view.

First, set Di 1 (AUTO SW) and Di 2 (MAN SW) to operate G02 BCA A/M SW.  The switching is also controlled by the Control-
ler’s front button.  Set Di 1 to set the A/M SW, and set Di 2 to reset it.

1)	 Drag Contact A command from the Module Window on the left and drop it in the ladder diagram setting window on the 
right.  Enter the terminal: 0511 in Enter Parameter dialog.  Alternatively click Browse button to choose Group 05 Terminal 
11 (Di 1) from the lists.

2)	 Drag and drop SET Coil command.  Enter the terminal: 0211 in Enter Parameter dialog.  Alternatively click Browse button 
to choose Group 02 Terminal 11 (A/M SW).

3)	 Drag and drop Contact A command in the next rung and specify the terminal: 0512 (Di 2).
4)	 Right-click the right-end command cell of the same rung and choose RESET Coil command.  Enter the terminal: 0211 

(A/M SW).
Next, set Di 3 (CAS SW) and Di 4 (LOC SW) to operate G02 BCA C/L SW.  The switching is also controlled by the Controller.  
Set Di 3 to set the C/L SW, and set Di 4 to reset it.

5)	 Drag Contact A command from the Module Window on the left and drop it in the ladder diagram setting window on the 
right.  Enter the terminal: 0513 in Enter Parameter dialog.  Alternatively click Browse button to choose Group 05 Terminal 
13 (Di 3) from the lists.

6)	 Drag and drop SET Coil command.  Enter the terminal: 0203 in Enter Parameter dialog.  Alternatively click Browse button 
to choose Group 02 Terminal 03 (C/L SW).

7)	 Drag and drop Contact A command in the next rung and specify the terminal: 0514 (Di 4).
8)	 Right-click the right-end command cell of the same rung and choose RESET Coil command.  Enter the terminal: 0203 

(C/L SW).
Next, set G02 BCA PV low alarm output and G02 BCA PV high alarm output to provide at discrete output terminals and at 
alarm lamp outputs.  Direct G02 BCA PV low alarm output (GGNN: 0202) to Group 05 Terminal 01 (Do 1) and Group 01 Ter-
minal 01 (AL1).  Direct G02 BCA PV high alarm output (GGNN: 0201) to Group 05 Terminal 02 (Do 2) and Group 01 Terminal 
02 (AL2).
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Created ladder setting diagram is as shown below.

0511

Di 1 Contact input signal

0211
( ON )

A/M SW (0=Manual, 1=Auto)

[ STEP00 ]

0512

Di 2 Contact input signal

0211
( OF )

A/M SW (0=Manual, 1=Auto)

0513

Di 3 Contact input signal

0203
( ON )

C/L SW (0=Local, 1=Cascade/Local)

0514

Di 4 Contact input signal

0203
( OF )

C/L SW (0=Local, 1=Cascade/Local)

0202

PV Low alarm output

0501
( OT )

Do 1 Discrete output

0101
( OT )

AL1 Lamp output

0201

PV High alarm output

0502
( OT )

Do 2 Discrete output

0102
( OT )

AL2 Lamp output



56SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

13.9	 DOWNLOADING SETTING DATA

Connect the SC100 to the PC.

Right-click the SC100 module in Station 00 / Card No. 0 slot and click Start button to start downloading.

13.10	 SAVING THE PROJECT

Save the setting data as a project file.

Choose File > Save or Save As to open “Create a New Project File” dialog.  Enter a project (file) name and comments, and 
specify its location.

13.11	 TUNING PID

The SC100 can start operations according to the downloaded function parameters.  In order to set the most appropriate PID 
parameters for the controlled object, fine tuning is available on the Controller’s Tuning view.

Go to Configuration view first and set the Config mode to ‘Front panel’ before accessing the Tuning view.

Refer to the SC100/200 Series Users Manual for detailed operation of the Controller.
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14.	 APPLICATION EXAMPLE WITH SML I/O MODULE

14.1	 APPLICATION EXAMPLE

The figure below shows an application example with the SML I/O module.

Four points of analog inputs at the SML-G4 (4 analog input module) are sent to the SML-S6 (4 analog output + 4 discrete 
output module) via NestBus for analog outputs and high limit alarm trips.

14.2	 14.2  PLACING THE DEVICE

Start up the SFEW3E program.  A blank System Configuration view is displayed.

Drag the SML-G4 icon from the Module Window on the left and drop it at Station 00, Card No. 0 slot in the Setting Window 
on the right.  Then drag the SML-S6 icon to drop at Station 00, Card No. 1 slot.

All modules within one NestBus must be placed in the same Station, usually Station 00.

Ai 2

Ai 1

Ai 4

Ai 3

Analog input 1

Analog input 2

G 11
Ao

G 12
Ao

Analog input 3

Analog input 4

Ao 2

Ao 1

Ao 4

Ao 3

SML-G4
Card 0

Analog output 1

Analog output 2

G 11
Ai

G 12
Ai

Analog output 3

Analog output 4

Do 2

Do 1

Do 4

Do 3

Analog output 1 high alarm

Analog output 2 high alarm

Analog output 3 high alarm

Analog output 4 high alarm

SML-S6
Card 1

NestBus
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14.3	 UPLOADING

Setting procedure may be simplified if the default setting saved in the hardware modules is uploaded to the SFEW3E pro-
gram.

Connect the SML-G4 module with the PC’s USB port via the COP-UM Configuration Cable.

Right-click the SML-G4 slot in the Setting Window and choose Upload.  Click Start button to start uploading.

Upload also the SML-S6 data.

The default setting of the SML-G4 can be used without additional setting in this example.

PC
SFEW3E

COP-UM

USB port

SML

Modular jack port
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14.4	 SETTING COMMUNICATION TERMINAL BLOCK

The SML-G4 and the SML-S6 modules are to be connected via NestBus.

Click Communication Terminal Connection button in System Configuration view to open the Communication Terminal Con-
nection view.

Connect between Group 11 of the SML-G4 and the SML-S6, Group 12 of the respective modules.

Click the terminal at one end to show a rubberband line and click where you want breakpoints before clicking the paired 
terminal.
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14.5	 ASSIGNING FUNCTION BLOCKS

High/Low alarm function is to be added to detect high alarm at the SML-S6.

Double-click the placed SML-S6 module in System Configuration view to open Function Block List view.

Alarm function blocks can be assigned to Groups 30 through 61.  Click Control [G30-61] group button in the left window and 
drag PVA 76 High/Low Alarm function block icon and drop it at G30 slot in the right window.

Four alarm function blocks are required to handle 4-point outputs at the SML-S6, therefore add PVA 76 function blocks at 
G31, G32, G33 slots.

Alarm contact output operations are handled in Sequential Control Block.  Assign Group 81 with SEQ 95 Sequential Control 
Program block.

Alternatively, double-click the G30 slot to open “Select Function” dialog to specify the High/Low alarm.
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14.6	 CONNECTING ANALOG TERMINALS

Click Analog Terminal Connection button in Function Block List view to open Analog Terminal Connection view.

Adjust positions of each module for ease of connecting lines between modules.

Click a terminal at one end to show a rubberband line and click where you want breakpoints before clicking a paired terminal.

Connect Ai 1 terminal (21) of G11 Ai Receive terminal module to Ao 1 terminal of G01 Field terminal module and to X1 input 
terminal of G30 High/Low alarm.

Connect Ai 2 terminal (22) of G11 Ai Receive terminal module to Ao 2 terminal of G01 Field terminal module and to X1 input 
terminal of G31 High/Low alarm.

Connect Ai 3 terminal (21) of G12 Ai Receive terminal module to Ao 3 terminal of G01 Field terminal module and to X1 input 
terminal of G32 High/Low alarm.

Connect Ai 4 terminal (22) of G12 Ai Receive terminal module to Ao 4 terminal of G01 Field terminal module and to X1 input 
terminal of G33 High/Low alarm.
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14.7	 SETTING FUNCTION BLOCKS

Go back to Function Block List view and double-click G30 PVA module to open Function Block Setting view for the High/Low 
alarm function.

Specify the high alarm setpoint.  Go to ITEM 12 and enter the setpoint value.

Go through the same procedure with G31, G32, G33 modules.

Click OK button to close the view.
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14.8	 SETTING SEQUENTIAL CONTROL BLOCK

Discrete signals are managed on Sequential Control Blocks.

Click Sequential Control Block Setting button in Function Block List view to open Sequential Control Block Setting view.

Right-click Group 81 slot and choose Enable Setting, then Step00 slot appears below Group 81 slot.  Double-click the Step00 
slot to open Ladder Setting view.

Start with the Ai 1 high alarm.

1)	 Place N.O. contact to receive signals from the G30 (High/Low alarm function) terminal 11 (Y1 High alarm).
	 Drag Contact A command from the Module Window on the left and drop it in the ladder diagram setting window on the 

right.  Enter the terminal: 3011 in Enter Parameter dialog.  Alternatively click Browse button to choose Group 30 Terminal 
11 (Y1 High alarm) from the lists.

2)	 Place SET coil to provide a contact output at G01 (Field terminal) terminal 01 (Do 1).
	 Drag and drop SET Coil command.  Enter the terminal: 0101 in Enter Parameter dialog.  Alternatively click Browse button 

to choose Group 01 Terminal 01 (Do 1).
Go through the same procedure for Ai 2 through Ai 4.



64SFEW3E  EM-6460-A Rev.9MG CO., LTD. www.mgco.jp
5-2-55 Minamitsumori, Nishinari-ku, Osaka 557-0063 JAPAN

14.9	 DOWNLOADING SETTING DATA

Connect the SML-S6 to the PC.

Right-click the SML-S6 module in Station 00 / Card No. 1 slot and click Start button to start downloading.

There is no need of downloading for the SML-G4.

14.10	 SAVING THE PROJECT

Save the setting data as a project file.

Choose File > Save or Save As to open “Create a New Project File” dialog.  Enter a project (file) name and comments, and 
specify its location.
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